High Tech Center Training Unit

Of the California Community Colleges at the
Foothill-De Anza Community College District

21050 McClellan Road
Cupertino, CA 95014
(408) 996-4636
(800) 411-8954

http://www.htctu.fhda.edu
# Table of Contents

Slide Handouts

Accessibility Options (Win 95/98/NT) ............................................. 1
Dragon NaturallySpeaking Preferred 3.0 (Win 95/98/NT) ............ 5
Duxbury Braille Translator ver. 10;2d (Win) ......................... 13
Inspiration 5.0 Educational Edition (Win 95/98/NT) ............. 17
JAWS 3.3 for Windows (95/98/NT) .................................................. 21
Kurzweil 1000 4.0 (Win 95/98/NT) ........................................... 39
Kurzweil 3000 3.0 (Win 95/98/NT) ........................................ 43
MAGic NT 5.1 (NT) .................................................................. 47
ZoomText Xtra (Win 95/98)......................................................... 49
Assistive Computer Technology in the California Community Colleges

A Presentation By
The High Tech Center Training Unit
of the California Community Colleges

Presentation Content

■ Background
■ What Is Assistive Computer Technology?
■ Who Uses Assistive Computer Technology?
■ What Does It Do?
■ College Responsibilities
■ Role of the High Tech Center Training Unit
Background

- The ability to access and use computer and other technologies has become essential to virtually every aspect of academic and professional life.

- Without equal access to technology, members of our society who have disabilities are greatly disadvantaged.

The Demographics of Disability

- We are living longer, and with longer life comes the possibility of disability. One in ten people will incur a significant disability in their lifetime.
Demographics

The United States Census Bureau reports:

- At the end of 1994, 20% of the population, about 54 million people, had some level of disability.

- 9.9%, or 26 million people had a severe disability.

Demographics

In 1994, among the 237 million people 6 years old and over:

- 1.8 million used a wheelchair.
- 8.8 million had difficulty seeing
- 10.1 million had difficulty hearing
In 1997, more than 1.4 million students were enrolled in California community colleges.

5% of those students, around 70,000 people, had disabilities which required special support services, including the use of assistive computer technology.

Student Disability Demographics

California CC Students with Disabilities - 1997

<table>
<thead>
<tr>
<th>Disability Category</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobility</td>
<td>13,891</td>
</tr>
<tr>
<td>Visual</td>
<td>2,830</td>
</tr>
<tr>
<td>Hearing</td>
<td>3,694</td>
</tr>
<tr>
<td>Speech</td>
<td>661</td>
</tr>
<tr>
<td>Learning Disabled</td>
<td>23,015</td>
</tr>
<tr>
<td>Brain Injury</td>
<td>5,698</td>
</tr>
<tr>
<td>Develop. Delayed</td>
<td>6,838</td>
</tr>
<tr>
<td>Psych. Disabled</td>
<td>7,588</td>
</tr>
<tr>
<td>Other</td>
<td>10,949</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>75,164</strong></td>
</tr>
</tbody>
</table>
Student Disability Demographics

By the year 2007, "Tidal Wave II" will have brought 350,000 additional students to our colleges. Thirty-five thousand of these students will have disabilities.

Meeting the Need

What has been done to meet the computer access needs of students with disabilities?

In 1987, the High Tech Center Training Unit for Students with Disabilities was established. Over the past 12 years, $20 million has been invested in building a state-wide support infrastructure, including:

- staff training
- facilities development
- purchase of assistive computer technology
High Tech Centers Program

- 114 community college High Tech Centers for students with disabilities have been established.

High Tech Centers Program

- The HTCTU was established to provide training and support for center staff and others in the use of assistive and instructional computer technologies.
High Tech Centers Program

- The HTCTU provides support for the selection, purchase and use of assistive computer technology in:
  - High Tech Centers
  - Libraries
  - Learning Centers
  - Open Media Labs
  - Campus networks

High Tech Centers Program

- The HTCTU provides information and support through:
  - in-house trainings
  - web sites
  - listservers
  - on-line databases
  - phone support
  - site visits
  - regional trainings
Assistive Computer Technology

- What is Assistive Computer Technology?
  - Assistive Computer Technologies (ACT) are software and hardware tools which can often provide equal access to computer resources for persons with disabilities.

Assistive Computer Technology

- How does it work?
  - ACT provides alternatives to the basic ways in which we interact with computers:
    - seeing the computer screen
    - reading the content of the screen
    - typing at the keyboard
Assistive Computer Technology

For persons who are blind or have low vision, "seeing the screen" with ACT means:

♦ software tools which verbalize the text content of the screen
♦ software tools which magnify the content of the screen

Assistive Computer Technology

For persons with learning disabilities, "reading the screen" with ACT means software tools which:

♦ verbalize screen content
♦ provide word definitions
♦ correct spelling
♦ monitor grammar and syntax
Assistive Computer Technology

- For persons with physical disabilities, "typing at the keyboard" with ACT means using software tools which:
  - convert spoken words into text on the screen
  - modify keyboard operation
  - predict and complete words and phrases

Assistive Computer Technology

- Other software and hardware tools which support computer access include:
  - software for the deaf and hard-of-hearing which provides visual representation of auditory prompts
  - scanners which capture the content of print documents for conversion to speech, electronic text or Braille
A Closer Look

■ ACT for students who are blind

♦ "screen reading" tools are rich and complex applications easily as challenging to learn and use as the best word processors or spreadsheet programs

♦ screen readers are available for Macintosh, DOS, Windows 95, 98 and Windows NT computers

A Closer Look

■ ACT for students who are blind

♦ screen readers work best with text based programs like word processors, e-mail, web pages and electronic books

♦ the most flexible and sophisticated screen reading systems are designed to work with Windows 95, 98 and Windows NT computers
A Closer Look

■ ACT for students who are blind

♦ typical of screen reading systems in use today are products from:

+ Henter-Joyce (JAWS)
+ G.W. Micro (Window-Eyes)
+ Telesensory (ScreenPower)

A Closer Look

■ ACT for students who are blind

♦ Although not all students who are blind read Braille, for those that do, the availability of text in Braille is essential for academic success

♦ At this time, California community college High Tech Center programs often produce Braille documents but do not teach students to read Braille
A Closer Look

■ ACT for students who are blind

♦ production of Braille requires software for translating text to Braille and a Braille printer. Typical examples include:
  + Duxbury Systems (Duxbury)
  + HumanWare (Juliet Interpoint)

A Closer Look

■ ACT for students with low vision

♦ screen magnification software works with text or graphics, is relatively easy to use and can generally be learned in a few hours

♦ screen magnification software is available for Macintosh, DOS, Windows 95, 98 and Windows NT computers
A Closer Look

- ACT for students with low vision
  - typical of screen magnification systems in use today are products from:
    + Ai Squared (ZoomText)
    + Henter-Joyce (MAGIC)

- ACT for students with learning disabilities
  - a variety of sophisticated software and hardware tools are available to provide assistance with reading and writing on the computer screen for students with visual processing deficits
    - the best and most flexible of these tools are available for Windows 95, 98 and Windows NT
A Closer Look

- ACT for students with learning disabilities
  - depending upon the tools selected, with regular practice, competency can generally be achieved within a few weeks
  - ACT for students with learning disabilities works best with text based programs

A Closer Look

- ACT for students with learning disabilities
  - typical of ACT for students with learning disabilities are products from:
    - Kurzweil [Omni3k]
    - Inspiration [Inspiration]
A Closer Look

■ ACT for students with physical disabilities

♦ at the present time, High Tech Centers provide ACT for students with mild to moderate physical disabilities

♦ these technologies include keyboard control and word prediction programs for Macintosh and Windows computers as well as speech recognition programs for Windows computers

A Closer Look

■ ACT for students with physical disabilities

♦ speech recognition programs typically require several hours of class time and many hours of practice to master. Keyboard control programs can be learned in minutes.

+ Microsoft (Access Options)
+ Dragon Systems (Nat. Speak)
College Responsibilities

- Under Title II of the ADA, California community colleges have a variety of responsibilities relative to technology and students with disabilities. These include providing access to:

  - Computerized library resources
  - Instructional computing resources
  - Virtual classrooms
  - Books/documents in alternative formats

Role of the HTCTU

- By providing a variety of resources, trainings and services, the High Tech Centers Training Unit helps community colleges meet these ADA responsibilities.
Role of the HTCTU

- The HTCTU offers trainings which help librarians become familiar with assistive computer technologies that provide access to computerized library resources for students with disabilities.
- The HTCTU can work directly with library and campus computing staff to select appropriate access technologies.

Role of the HTCTU

- The HTCTU offers a wide variety of on and off-site trainings intended for High Tech Center specialists and other faculty and staff who work with assistive computer technology and students with disabilities.
Role of the HTCTU

- The HTCTU offers training and technical support which helps community college faculty and staff develop web based virtual classrooms that are accessible to students with disabilities.

Role of the HTCTU

- Additionally, the HTCTU provides:
  
  Technical support by phone  
  Site visits  
  Assistance with computer/network access and facilities planning  
  Web site resources ([www.htctu.fhda.edu](http://www.htctu.fhda.edu))  
  Listservers  
  Internet access for DSP&S staff
High Tech Center Training Unit
of the
California Community Colleges

High Tech Center Training Unit
21050 McClellan Road
Cupertino, CA 95014

http://www.htctu.fhda.edu
(408) 996-4636
Toll Free (800) 411-8954
FAX (408) 996-6042
TDD (408) 252-4938
Accessibility Options (Win 95/98/NT)

Publisher: Microsoft Corp.
One Microsoft Way
Redmond, WA 98052-6399
(206) 635-7245
http://www.microsoft.com/enable

Retail Cost: Included in OS

System Requirements:
The Accessibility Options are found in the Windows 95/98/NT Control Panel which is accessed through Settings on the Start menu. The Accessibility Options are included in the default Windows 95/98/NT installation.

Description:
The Accessibility Options include five types of adaptive system support: Keyboard, Sound, Display, Mouse, and General. Note that there is no Display Tab on the NT Control Panel.

Recommended Uses:
The Options provide system support for: persons with physical difficulty in using the keyboard; persons who have visual disabilities and need larger print, stronger contrasts or larger mouse pointer; persons who are deaf or hard of hearing and need to see sound events; and, persons using a serial device to connect to the computer. What is singular about this cluster of operating system support is the fact that previously, almost all of these features had to be purchased from third party vendors.

Basic Use:
1. Enter Ctrl-Escape to bring up the Start menu.
2. Double Click on Accessibility Options. The Accessibility Properties window appears.
3. Click on a properties tab to go to a support feature.

The Keyboard Properties Tab
Three features: StickyKeys, FilterKeys, ToggleKeys are available; each has a settings window which is reached by clicking on a Settings button.

- StickyKeys
Use sticky keys to latch the special keys (Ctrl, Alt) or the shift keys. When one of these keys is pressed, it latches and releases only when a second key is
pressed, e.g., Ctrl-P. Tapping shift or a special key twice latches it down (e.g., to type many asterisks); tapping it again will unlatch it if that option has been set. This feature is used when the keyboard user is unable to hold two keys down at the same time.

The keyboard shortcut to turn sticky keys on is to tap the Shift key 5 times. There are additional options which may be selected for the StickyKeys feature: turn off StickyKeys when two keys are depressed at the same time (automatically turning the feature off for a regular typist); make a sound when a special key is pressed, and a very important feature, the ability to show a visual display of whether a special key is latched or not (not available in NT). Having the visual display on the screen is useful information for persons with short term memory deficits. Right clicking on this reminder brings up an option to adjust settings.

- **FilterKeys Properties Tab**
There are two types of options which may be set from the main FilterKeys property sheet. The one most frequently used is the second radio button option. This controls the function of RepeatKeys and SlowKeys.

1. **RepeatKeys**
   - This option will override settings on the Keyboard control panel. It is possible to turn off keyboard repeat entirely, or is it possible to slow down the rate at which the key repeat function repeats. Students with slow visual processing speeds benefit from a slowed key repeat function because it is easier to track the cursor. Students who are unable to quickly lift their hands off a key will benefit from having the repeat delay increased (a finger can stay on a key a bit longer before a key repeat begins).

2. **SlowKeys**
   - The SlowKeys function allows the user to set a time delay before a keystroke is registered. This in effect can create a virtual keyguard for the student who strikes many keys while moving over the keyboard to the target keystroke. No keystroke will be registered until a key has been depressed for a minimum length of time.

The keyboard shortcut which turns FilterKeys on is to hold down the **Right Shift** key for eight seconds. This option will not work unless the **Use shortcut** box is selected.

- **ToggleKeys**
  - Choosing this function invokes a tone when one of the special locking keys is pressed (Caps Lock, Scroll Lock, Num Lock).
**The Sound Properties Tab**

At the current time, only one of the two options works: **SoundSentry**. Using this option generates visual warnings when a system sound occurs. From its Settings window, it is possible to have alerts for windowed programs or full screen text programs (not available in NT).

- **For Windowed Programs**
  - Flash active window or flash the desktop

- **For Full Screen Text Programs**
  - Flash display, characters, or border

The ShowSounds feature will display captions for speech and sounds generated by an application which has been designed to work with this feature. Currently this feature is not widely supported.

**The Display Properties Tab (not available in NT)**

From the front of this panel it is possible to invoke **High Contrast** color scheme if an application is "smart" about this feature. The **Settings** window allows the user to choose to invoke the shortcut key, **Left Alt-Left Shift-PrintScreen** and to set specialized high contrast color schemes.

It is possible to set everything to **white on black** or **black on white**, or specialized color sets. Many color sets come with standard, large and extra-large font choices.

**The Mouse Properties Tab**

Only one set of functions is controlled by this tab: the ability to use the numeric keypad to move the mouse pointer. It is possible to modify cursor speed as well as to use Ctrl to speed up mouse movement and **Shift** to slow down mouse movement.

**The General Control Panel Tab**

- **Automatic Reset**
  From this level it is possible to set a time limit on keyboard inactivity; when that limit is reached, all accessibility functions automatically turn off.

- **Notification**
  It also is possible to ask for warning messages when features turn on (not available in NT), or to set a sound to occur when a feature is turned on and off.
- **SerialKey Devices**
  For students needing to connect serial communication devices to a computer, this access panel allows the user to set which serial port to use and what baud rate to use.

**Notes:**

**Installation:**

The Accessibility Options control Panel is part of the default Windows installation. If it is not installed, do so by going to the Windows Setup or Windows NT Setup tab of the Add/Remove Programs Control Panel. Check the box next to Accessibility Options and click OK. If the files are not on the local or network drive, you may have to insert the CD when asked.
**Publisher:** Dragon Systems  
320 Nevada Street  
Newton, MA 02160  
(800) 825-5897  
http://www.dragonsys.com

**Retail Cost:** $229.00 approx.

**System Requirements:**
Microsoft Windows 95/98 or newer, or Windows NT, 133 MHz or faster, 32 MB RAM for Windows 95/98, 48 MB RAM for Windows NT (64 MB recommended).

All systems require a sound board. Currently, the following soundcards have been tested and certified for Dragon NaturallySpeaking:

- Sound Blaster 16 PnP (Creative Labs, Inc.)
- Sound Blaster AWE32TM PnP (Creative Labs, Inc.)
- Sound Blaster AWE64TM PnP (Creative Labs, Inc.)
- Sound Blaster AWE64TM Gold PnP (Creative Labs, Inc.)
- AudiotrixTM Pro (MediaTrix Peripherals, Inc.)
- EnsoniqTM SoundScapeTM VIVO 90 (must be purchased directly from Ensoniq, Corp.)
- EnsoniqTM Audio PCI (32-bit) (Ensoniq Corp.)
- ExpertMedia Med 3240 with OPTi chip set (Expert Media)
- Turtle BeachTM Tropez Plus (Turtle Beach Systems).

**Description:**
Dragon NaturallySpeaking is a speaker dependent, continuous speech recognition system. The active vocabulary size is 30,000 words with a 230,000-word dictionary which allows for accurate word prediction and spelling. Text can be dictated at around one hundred words per minute. The system accommodates multiple voice profiles per computer.

**Recommended Uses:**
This program is recommended for persons with repetitive strain injury or moderate to severe physical disabilities that impair keyboard usage. Users must be able to produce consistent speech output.

**Basic Use:**
Each user must individually train Dragon NaturallySpeaking. Training is accomplished through use of the General Training program. Creating a voice
profile and completing the training process takes about 45 minutes. Unlike previous versions of Dragon Dictate which were always used in combination with other programs, often, word processors, NaturallySpeaking works within its own dedicated word processing environment and is intended for text dictation rather than applications control. When using NaturallySpeaking, the following steps are taken:

1. Load NaturallySpeaking from the Programs menu.

2. Activate the microphone by pressing the numeric keypad + key.

3. Begin speaking clearly and distinctly in short phrases with brief pauses between each phrase.

4. If a phrase or word selected by NaturallySpeaking is incorrect say "Correct" and the word or phrase to be corrected.

5. If the correct phrase or word appears in the suggestion list, say "Choose" and then the number of the desired phrase or word in the selection box.

6. If the desired phrase or word does not appear in the selection box, say "Spell That" and begin spelling the word using the letters of the alphabet. Generally, the correct phrase or word will be identified after the first one or two letters have been spoken. When the desired phrase or word appears, say "Choose" and the number of the phrase or word.

Intermediate Use:

Users can insert punctuation marks by saying the name of the mark, (i.e. "period," "comma," "question mark"). A variety of options exist for selecting text. Saying "Select" then word, line, paragraph or document selects a portion of text which can then be edited or formatted in a number of ways. (See attached Quick Reference Guide)

Reading Text

Listening to text that has been dictated provides a useful method for identifying misrecognition errors. NaturallySpeaking provides two methods for listening to dictated text:

To play back digitally recorded speech of your voice dictating text, select the text to be read (i.e. say "select previous paragraph") then say "play that back." Please note that this option only works for text that has not been previously saved and then reloaded.
To play back computer generated speech of any text in the NaturallySpeaking composition window, select the text to be read (i.e. say "select previous paragraph") then say "read that." This option works for any text file.

**Topic Builder**

In order to improve recognition accuracy, NaturallySpeaking provides a Topics option which extracts, analyzes and stores specialized vocabulary drawn from documents you’ve submitted for review. Topics are specific to each user and include one "general purpose" Topics list and as many other specialized vocabulary lists as needed.

To use this option, select **Topic Builder** from the **Tools** menu and select any MS Word document or plain text file which contains the specialized vocabulary you wish to include. **Topic Builder** scans the document, determines word and language usage patterns and rebuilds the **Topics** vocabulary.

**Mouse Grid**

NaturallySpeaking provides a **Mouse Grid** navigation system similar to that used in previous and current versions of Dragon Dictate to move the mouse pointer. Saying "**MouseGrid**" displays a 3x3 grid with nine numbered squares which cover the entire screen. Saying the number of a square "refocuses" the grid to the selected square. Repeating the selection process moves the mouse pointer to the desired object by a process of approximation. Saying "click" selects the object.

Saying "**MouseGrid Window**" opens the Mouse Grid in the current window. Additional fine-tuning of the mouse pointer can be accomplished by using a limited set of mouse movement commands. Say "mouse (up, down, left or right)" followed by a number between 1 and 10, will move the mouse a few pixels in the selected direction. For example, saying "mouse up 9" would move the mouse pointer up about one-eighth of an inch.

**Notes:**

Speaking distinctly and in short phrases will dramatically improve recognition performance. Saying "Thank you for your letter" brief pause "inviting me to the opera" brief pause "next Saturday night" will work better than saying the whole sentence. The Deluxe edition supports a larger vocabulary, macros, multiple topics and Command Wizard. It includes both Dragon Dictate (for hands free computer control) and Naturally Speaking (for continuous text dictation). At the present time, these two programs are not well integrated and should be considered separate applications. Naturally
Speaking Preferred Edition is a multi-user version available for $229.00. It has a smaller vocabulary and does not support multiple topics. Naturally Speaking Standard Edition is a single user version which does not support reading or playback of dictated text. It is available for about $109.00. Version 3.0 includes the following new features and improvements. Note that not all features are available in all editions.

**What's new in version 3.0?**

- A New User Wizard guides you when you first use Dragon NaturallySpeaking and each time you create a new user.

- BestMatch™ technology, which provides improved recognition on systems with faster processors and larger memories, is available in all editions.

- NaturallyMobile™ lets you dictate into portable recorders and transcribe your dictation into Dragon NaturallySpeaking. NaturallyMobile is available in the Preferred and Professional editions.

- NaturalText™ support for dictation in other applications is now available in all editions.

- NaturalWord™ modules are now available in all editions. NaturalWord can now provide NaturallySpeaking functions in both Microsoft Word 97 and Corel® WordPerfect® 8.

- NaturalWord for Microsoft Word 97 includes Natural Language Commands, which provide a natural way of controlling Word 97.

- Preferred and Professional editions now let you simulate pressing any key or key combination by voice.

- Preferred and Professional editions include a performance tuner that lets you tune Dragon NaturallySpeaking to maximize your computer’s configuration.

- Select-and-Say™ has been improved to provide more ways to revise your words.

- The Quick Tour has been enhanced with new dictation instructions.

- This version works with Windows 98.

- Many additional improvements and fixes have been made.
NaturallySpeaking

At a glance, here are all the voice commands grouped according to when you can say them.

Global Commands

Microphone Off
Go to Sleep/Wake Up
Click (Menu or Button Name)
Move Left/Right/Up/Down 1-20
Move Left/Back/Right/Forward 1-20 Characters
Move Up/Down/Back/Forward 1-20 Lines
Select Next/Forward/Previous/Back Character
Select Next/Forward/Previous/Back Lines
Delete Next/Forward/Previous/Back Character
Delete Next/Forward/Previous/Back 1-20 Characters
Undo Last Action
Undo That
Copy All to Clipboard
Paste That
Switch to Next/Previous Window
Switch to Next/Previous Window
Switch to NaturallySpeaking
What Can I Say
Give Me Help
Give Me Help on (Topic)

Editing Commands

Go to Top/Bottom
Move Left/Back/Right/Forward/a word
Move Left/Back/Right/Forward/ 1-20 words
Move Left/Back./Right/Forward/ a paragraph
Move Left/Back/Right/Forward/ 1-20 paragraphs
Move to/Go to
  Top/Start/Beginning/End of line/Paragraph
  Document/Selection
Select Word/Line/Paragraph/Document
Select Next/Forward/Previous/Back Word
Select Next/Forward/Previous/Back 1-20 words
Select Next/Forward/Previous/Back Paragraph
Select Next/Forward/Previous/Back 1-20 Paragraphs
Set Font (Face/Size/Style)
  face = Arial, Courier, Courier New, Times,
Times New Roman

size = 4-120

style = Bold, Italics, Plain, Plain Text, Regular, Underline

**Dictation Commands**

New Line/Paragraph
Tab Key
All Caps
All Caps On/Off
Caps
Caps On/Off
No Caps
No Caps On/Off
No Space
No Space On/Off

**Recorded Speech and Text Playback Commands**

Play That Back/Read That
Play Back/Read
   Line/Paragraph/Document/Window/to Here/from Here

**Correction Commands**

Scratch That
Correct That
Correct text
Select text
Select Again
Spell that abc
All Caps That/Selection
Cap That/Selection
No Caps That/Selection

**Correction Dialog Box Commands**

Choose 1-10
Select 1-10
Select Line
Select Next/Forward/Previous/Back Word/Character
Select Next/Forward/Previous/Back 1-20 Words/Characters
Move Left/Back/Right/Forward a Word/Character
Move Left/Back/Right/Forward 1-20 Words/Characters
Move to Top/Start/Beginning/Bottom/End of Line
Go to Top/Bottom
Go to Top/Start/Beginning/Bottom/End of Line
Cut That/Selection
Delete That/Selection
Delete Next/Forward/Previous/Back 1-20 Words/Characters
abc = Letters a-z, numbers 0-9 apostrophe, dash, hyphen, space bar, Cap,
question mark, slash
other punctuation marks (say with a brief pause)

Using Naturally Speaking with Other Applications

Say:

Copy All to Clipboard
Switch to Previous Window
Paste That

Network:

It is not recommended to run Dragon Naturally Speaking from a server.
Even moving voice files from one computer to another requires a special
sequence of steps.

Installation:

For NT installations, always login as Administrator for that computer. Be
sure to have the Install Key for the program, then insert the CD into the
drive and wait for the install program to start. If your PC does not have
autorun enabled, you will have to run setup either from the run command or
by browsing in the Explorer. Follow the onscreen directions to install the
program.

Most problems with Dragon NaturallySpeaking stem from a poor signal to
the program. This may be caused by any of the following: incompatible
sound card, a bad microphone, microphone not matched to sound card which
may need a booster pack installed, poor voice quality such as not loud enough
or inconsistent speech production. High quality microphones are
recommended to compensate for these problems.
Duxbury Braille Translator ver. 10;2d (Win)

Publisher: Duxbury Systems
270 Littleton Road Unit 6
Westford, MA 01886-3523
978-692-3000
http://www.duxburysystems.com/

Retail Cost: $595.00
(upgrade pricing available)

System Requirements:
A Pentium machine running Windows 3.1 or Windows 95, or 98. A braille embosser is required if braille materials are to be produced.

Description:
This software translates text to grade 2 braille and exports it to a braille embosser. Grade 2 braille has the same alphabet as grade 1, but it has added contractions for many words and word segments. The software can also be configured to export a braille file to a printer if a print copy is desired.

Recommended Uses:
DBT is simple to use and yet its broad range of capabilities and its accuracy have made it a program widely used by most major braille production centers. This program installs a braille font in the Windows system. This font can then be used by other programs: e.g., for text labels in a graphics program used to create maps or diagrams for blind students (such material can then be "toasted" by a graphics image enhancer to produce tactile images).

Basic Use:
The file formats most efficiently supported by Duxbury are ASCII, SGML/ICADD, and WordPerfect versions 5.0, 5.1, 5.1+, 5.2, 6.0, and 6.1. The easiest way to import a Word file is to save it as a WordPerfect file before opening it in Duxbury.

Once a file is opened in Duxbury, it is possible to see it as text or as braille. It also is possible to create a text file in Duxbury and then convert it to braille. It also is possible to import a file created in braille. Duxbury supports a six-key braille editor for those familiar with six-key braille input.

Duxbury is "smart" about formatting, and in most cases, there is no need to take advantage of the many formatting options which Duxbury does provide. While viewing text of in imported file, it may be necessary to remove minor extraneous characters before converting the file to braille.
Basic Steps to Import a File into Duxbury

1. Have ready a saved Microsoft Word document, (e.g., created in Office 97) Make sure the braille embosser is turned on.
2. Start the Duxbury program.
3. From the Duxbury file menu, select Open.
4. From the Import File window, make sure Standard file format is selected in the top window, and Microsoft Word 7 or 97 is selected as the filter in the lower window. Click OK.
5. The file text appears on screen.
6. From the File menu, select Translate. The file changes to Braille form.
7. From the File menu, select Emboss, and the material is sent to the braille embosser. (Or, at this point it is possible to select Print if the braille material is to be sent to a standard printer for a print copy of the braille.

The Production of Graphic Images

With the recent introduction of graphic image enhancers (one from Reprotronics or p.i.a.f. [Picture in a Flash] from HumanWare) there are numerous kinds of tactile materials which can be created for braille users:

- Charts
- Diagrams
- Maps
- Other Innovative Study Aids

Important: The fact that Duxbury installs a braille font into the Windows system allows other computer applications to use a braille font.

A chart or graph or a small braille file can be printed on regular paper and then Xeroxed onto heat-sensitive paper that will "puff" in the p.i.a.f. or other graphics enhancer

Braille and Print

If Interline Print is selected in the Print window, Duxbury also can print a text copy of each line under each braille line so that it is possible to get a printout of both text and braille, or if sent to a braille embosser which also supports printing, braille and print can be produced simultaneously.
Current Version (10;2d) Features

- American Math/Science Code (Nemeth) translation.
- Intermediate levels (between grade 1 and 2) for American braille.
- The ability to include tactile graphics files for mixed text-and-graphic documents.
- Separate work-alike versions for Windows (3.x, 95, 98 and beyond, NT 4. and beyond), MS-DOS and Macintosh, and a file prepared on any platform can be used on any other!
- Imports from popular word processors including Microsoft Word and WordPerfect, HTML, ICADD, formatted and plain ASCII, earlier braille editors such as EDGAR and Polkadot, and Duxbury’s own historical file formats, and more.
- The current (February 1998) translation table menu includes ten major languages plus four variations, including grade 2 support for most jurisdictions where grade 2 is customarily used. DBT allows languages other than the principal language to be embedded in the same file and treated as appropriate for the context.
- Bidirectional (print-to-braille and braille-to-print) translation.
- American Computer Braille Code (CBC) translation.
- American textbook layout according to Braille Authority of North America (BANA) standards, and likewise the Braille Authority of the United Kingdom (BAUK) customs for the same purpose.
- Accurate presentation of both print or braille in either WYSIWYG (what-you-see-is-what-you-get) or coded (how-you-get-what-you-want) views in the word-processing screen, with easy switching between views.
- A "translated line" showing the "other" form in either print or braille files.
- Six-key chording for braille and print entry, not timing-based, compatible with most keyboards.
- Help screens throughout the program.
- Documentation in print, braille & electronic formats.
- Over 100 formatting & translation codes for a high level of flexibility.
- A library of user-configurable styles A user-extendable template library for even more flexibility.
- A spell-checker with 300,000-word dictionary.
- A "Quick. Find Misspelling" feature for increased speed and ease of use.
- The Duxbury Braille Font for viewing braille dots within other programs
- Choice of single-user, site & other licenses.
- The ability to process files as large as the operating system allows the ability to have multiple files open simultaneously.
**Notes:**

Pricing for other platform versions of Duxbury:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBT DOS</td>
<td>$550</td>
</tr>
<tr>
<td>DBT Win</td>
<td>$595</td>
</tr>
<tr>
<td>DBT Mac</td>
<td>$645</td>
</tr>
<tr>
<td>DBT Dual (DOS &amp; Win)</td>
<td>$750</td>
</tr>
</tbody>
</table>
**Inspiration 5.0 Educational Edition (Win 95/98/NT)**

**Publisher:**
Inspiration Software Inc.
7412 SW Beaverton Hillsdale Highway
Suite 102
Portland, OR 97225
(800) 877-4292; (503) 297-3004
(503) 297-4676 fax
www.inspiration.com

**Educational Cost $69.00**

**System Requirements:**

**Macintosh**
Mac Plus or higher, system 6.0.4 or higher, System 7.x or 8.x; minimum 2 MB available RAM; hard disk required.

**Windows**
Compatible with Windows 3.1, Windows 95 or Windows 98; 8 MB RAM, 386,486, or Pentium processor or higher running at 16 MHz or faster; VGA, SuperVGA, or other Windows 3.1 or Windows 95 compatible graphics card and monitor.

**Description:**

Inspiration is a powerful visual learning tool that inspires students to organize their thinking. Students use Inspiration's Diagram view to dynamically create and modify concept maps, webs, and other graphical organizers. The integrated Outline view enables students to quickly prioritize and rearrange ideas, helping them create clear, concise writing.

Inspiration helps the user visually develop and organize ideas. Its free-form Diagram view stimulates creativity while helping to reveal new relationships, thoughts, and perspectives. Toggle to the integrated Outline view to develop ideas into a written report.

Inspiration makes creating concept maps and webs easy. Concept maps and webs are powerful visual learning tools. They are visual diagrams that represent relationships between ideas. Concept maps and webs help organize information and develop higher level thinking skills, enhancing knowledge and clarity of thought.

**Recommended Uses:**

Inspiration is used across the curriculum in writing classes, literature classes, and in science, social studies, math. It also can be used for
organizing multimedia projects; in its most recent version, the outline view can be saved in HTML format.

Inspiration is especially useful for a visual learner; for some students with learning disabilities, organizing information using written outline format is very difficult. By organizing in Inspiration’s graphical mode, students are able to express visual relationships which convey the information they want to express. Converting this visual display to a text-based outline (with perhaps some special notes attached to some of the graphical items) provides a verbal organizational structure which students can then flesh out in writing.

**Basic Use:**

The following activity will take the user through initial steps of creating a visual outline.

**Main Idea**

- type: The Role of Pets
- click on: an arrow in the shape tool
  - type: a source of income
- click on: The Role of Pets
- click on: an arrow in the shape tool
  - type: provides company

**To Do Rapid Fire**

- press: select the Rapid Fire tool from the tool bar and click on the text to which idea boxes will be attached. A red lightening bar will appear. (from the keypad)
  - type: for children
- press: enter
  - type: for the sick
- press: enter
  - type: for the elderly
- press: enter

**To Create Different Shapes**

- click on: provides company
  - click on a shape from symbol palette
To Delete Links

click on: arrow from Role of Pets to Source of Income
press: delete key

To Draw Links

select: The Role of Pets
position pointer on diamond-shaped handles at the top
click and drag the link to the Source of Income symbol
(to delete link, select it and delete)

To Edit Diagram or Outline

click and drag items anywhere

Adding Text to Link
Click on the middle of a link; an edit box will appear
type: As mentioned in the news

To Change Text Font and Style

select: text in any box
go to: the FORMAT menu
select: FONT
select: font choice

For Rushwriting

select: any shape
double click: upper left corner rectangle, write notes

To View on One Page

Ctrl E, or from View menu, select Zoom and the Fit to Window;
To See in Outline Format

Ctrl T, or from View menu choose Outline

To Print on One Page

From File menu, select Print Options and select Fit to 1 Page radio button.

Notes:

JAWS 3.3 for Windows (95/98/NT)

Publisher: Henter-Joyce, Inc.
11800 31st Court North
St. Petersburg, FL 33716-1805
(800) 336-5658
http://www.hj.com

Retail Cost: $ 795/1495
(See Notes section for more Purchase Information and Software Maintenance Agreement information)

System Requirements:
To use JAWS for Windows, version 3.3, you need:

- A personal computer that will run the Microsoft Windows® 95 operating system or later, or the Microsoft Windows NT® Workstation 4.0 or later.
- If Eloquence, the free software synthesizer for JFW software will be used, a Windows 95 or Windows NT compatible sound card is necessary. If Eloquence is not used, a JFW compatible hardware synthesizer such as the DECTalk Express is required.
- 30MB of available hard disk space required.
- VGA or higher-resolution video adapter (Super VGA 256-color recommended).

As with most systems, the faster the processor and the more memory your computer has the better the performance of your computer and our product.

JFW 3.3 for Windows 95 is a true 32-bit program, and will not work in the Windows 3.1x environment. For the convenience of those who need speech access in the Windows 3.1x environment, JFW 2.0 is also included on the installation CD.

JAWS supports Microsoft Word under Microsoft Windows 95, 98 and Microsoft Windows NT. When using Microsoft Windows NT, Service Pack 4 or later is required. For system requirements for Microsoft Word, refer to the Microsoft Word documentation. For most complete Web access, MS Internet Explorer (IE) 4.01 or 5.0 must be used. Version 4.01 of IE is on the JFW 3.2 distribution CD.

Description:
JAWS for Windows is a screen reader that uses the numeric keypad for its basic reading functions. A number of interactive hot key commands are available to change settings easily; these generally are prefixed by the Insert key and then a letter, number or function key from the alpha side of the keyboard.
There are two particularly strong features in JAWS which help the user: Verbosity Level and Help.

1. There are three levels of verbal assistance provided to the user: a lot (beginner), some (intermediate) and little (advanced). The default full verbosity level is very informative for the new user.
2. The extensive help functions in JAWS for Windows are well developed. The on-line help for JAWS is rich, and there is included an additional level of help: context-sensitive help.

Extensive information about the Windows environment is included with the JAWS documentation. A developed scripting language also comes with JAWS so that advanced users may configure JAWS for unique applications or customize an existing application configuration.

**Basic Commands:**

**Working with Context Sensitive Help**
JAWS has a powerful on-demand Help feature that provides verbal information and/or instructions for a current task. At any time:

- use **Insert Fl** to hear screen sensitive help—useful for learning windows.
- use **Insert F1,F1** to bring up application-specific help window in major applications: e.g., Word.
- use **Insert H** to hear JFW hot key commands and/or context-sensitive, application-specific help.
- use **Insert W** to hear Windows keyboard commands.

**Working with Keyboard Help Mode**
JAWS supports a user-exploration mode. This function, called the Keyboard Help Mode, is toggled on by **Insert-One** (from the number row on the alpha portion of the keyboard). When this function is turned on, all letter keys echo their identity, and all command sets, e.g., **Insert V**, do not actually perform a function, but instead are identified and their function described. This mode is toggled off by entering **Insert-One**.

**About the JAWS Interface**
JAWS uses the numeric keypad as its keyboard base for special reading commands. Two cursors are monitored: a JAWS cursor and PC cursor.

The JAWS cursor is directly linked to the Microsoft Windows mouse pointer. Like the mouse pointer, it is possible to move around windows with the JAWS cursor while the PC cursor remains at its current location. Likewise, the JAWS cursor stays stationary when the PC cursor moves and remains in
a fixed location until activated. As in the case of the mouse pointer the JAWS cursor is not affected when you type.

The PC cursor is directly linked to keyboard operations. To activate the PC cursor, press **Numpad Plus**. To activate the JAWS cursor, press **Numpad Minus**. Only the PC cursor or the JAWS cursor can be active at any one time.

It is possible to toggle between the two cursors, and it is also possible to route one cursor to the other cursor. **Insert Minus** routes JAWS to the PC cursor. **Insert Plus** routes the PC cursor to the JAWS cursor.

Interactive reading is also possible by using the standard arrow keys. There are two types of commands in JAWS: the majority are reading commands issued from the numeric keypad, but there also are interactive settings commands issued from the alpha keyboard.

**How JAWS Settings are Managed**

Basic screen reader settings such as voice pitch and rate, type of keyboard announcement, etc., are accessible through a menu bar in the JAWS Settings Window. Use **Insert J** to bring up the JAWS application window. (Although many functions available through the menus can be configured by hot key commands.) There are five menu options:

1. **File** (use to have JAWS start first, to change from full to laptop keyboard, or to exit the JAWS program)
2. **Voices** (use to change speech rate; unchanged from Ver. 1)
3. **Utilities** (to access Macro Editor or Configuration Wizard—for advanced use)
4. **Language** (use to change languages, if installed, or to change synthesizers, if installed)
5. **Help** (Contains good information: JFW Help Topics, Quick Reference, What’s New, Customizing JAWS [for advanced use], a selection for how to get technical support, and an option listing the user’s JFW version number and serial number). A copy of the user license agreement is also accessible through the Help menu options.
Refreshing the Screen
Sometimes JAWS does not seem to read properly, and when this is suspected, refreshing the screen display with the JAWS command Insert Escape will usually restore normal reading function.

How to Open a Menu
1. Tap the Alt key and then tap the first letter of the menu option. Once the Alt key has been tapped, it is possible to arrow across through the main menu options.
2. Move down in the menu with the Down arrow key.
3. Tap the Enter key after hearing the desired topic announced to open its settings box.

Interactive Hot keys from the Alpha Number Row
Insert-1 Toggles the keyboard help on or off.

Insert-2 Toggles through the keyboard echo function: characters, words, or none.

Insert-3 Use this before entering an application command that is identical to a JAWS command; JAWS will ignore the command.

Insert-4 Toggles to standard or active graphics mode. Use active graphics mode if JAWS does not read all tool bar buttons.

Insert-5 Reads color of text at cursor.

Insert-6 Hot key to bring up the Configuration Manager.

Insert-7 An advanced command to work with types of window classes.

Insert-8 Brings up Keyboard Manager, an advanced component. The Keyboard Manager allows you to create application specific key map files. To create a key map file for a specific application, start the Keyboard Manager from the hot key. After you start the application, press Insert+8 to start the Keyboard Manager.

Insert-9 Brings up Frame Manager, an advanced component.

Insert-Zero Brings up JAWS Script Manager, an advanced component.
**Interactive Hot Keys from the Alpha Keyboard**

**Insert B** Read all of dialog box in Tab order. This allows the user to understand what is in a dialog box before attempting to Tab through its topic area.

**Insert C** in some applications will read word in context (e.g., spell check).

**Insert F** Identify font name, size and attribute of text at active cursor.

**Control Insert F** Brings up JAWS Find dialog.

**Insert H** Context-sensitive hot key application-specific help is verbalized.

**Insert E** In a dialog box or special window, announces what button will be selected if **Enter** is tapped.

**Insert J** Bring JAWS window forward. If JAWS is minimized, this will maximize the window; if JAWS is open but covered, this will bring the window forward.

**Insert F4** Unload JAWS.

**Insert F6** Minimize all applications on the desktop.

**Insert R** Restrict action of JAWS cursor. If this is turned on, JAWS will read only in the active child window. When restriction is toggled off, JAWS cursor can read anywhere on screen display.

**Insert S** Toggle through screen echo settings.

**Insert T** Read title bar of window.

**Insert V** Brings up Adjust JAWS Verbosity list box. Tapping the Space Bar toggles through verbosity levels of selected item in list box. Specific verbosity levels may be set for user preference, graphics, ANSI characters, Braille, screen echo, typing echo, and mute synthesizer.

**Insert W** Speaks general Windows help.

**Speech Pad Minus** Turn on JAWS Cursor.
**Speech Pad Plus** Turn on PC Cursor. The PC cursor tracks the insertion point or the highlighted selection cursor.

**Insert Up Arrow** Read Current Line.

**Up Arrow** Read Prior Line.

**Down Arrow** Read Next Line.

**Left Arrow** Read Prior Character.

  **JAWS Cursor** Speak Prior Character.

  **PC Cursor** Select prior icon, select prior menu item, or move insertion point to the prior character.

**Right Arrow** Read Next Character.

  **JAWS Cursor** Speak next character.

  **PC Cursor** Select next icon, select next menu item, or move insertion point to the next character.

**Speech Pad 5** Read Current Character.

**Insert Left Arrow** Read Prior Word.

**Insert Right Arrow** Read Next word.

**Insert Speech Pad 5** Read Current Word.

**Insert Speech Pad** 5 (pressed twice within a half second) Spell Current Word.

**Page Up** Move Up One Screen or to Top of Window.

  **JAWS Cursor** Move to top of active application or child window depending on the setting for JAWS cursor restriction. (Information about cursor restriction is presented elsewhere in this chapter.)

  **PC Cursor** Move insertion point up one screen.

**Page Down** Move Down One Screen or to Bottom of Window.
**JAWS Cursor** Move to bottom of active application or child window depending on the setting for JAWS cursor restriction. (Information about cursor restriction is presented elsewhere in this chapter.)

**PC Cursor** Move insertion point down one screen.

**End** Move to the End.

**JAWS Cursor** Move to the end of text on the current line or to the last graphics on current line.

**PC Cursor** Performs the End function for the application. For example, it could move the insertion point to the end of text on the current line or to the last item in a list box.

**Home** Move to the Beginning.

**JAWS Cursor** Move to the beginning of text on the line or to the first graphics on the line.

**PC Cursor** Performs the Home function for the application. For example, it could move the insertion point to the beginning of text on the current line or to the first item in a list box.

**Insert Home** Speak From the Left Edge of the Window to the Cursor.

**Insert Page Up** Speak From the Cursor to the Right Edge of the Window.

**Insert End** Read Top Line of Window.

**Insert Page Down** Read Bottom Line of Window.

**Insert Delete** Speak the Coordinates of the Active Cursor.

**Insert Minus** Route (move) the JAWS Cursor to the Location of the PC Cursor.

**Insert Plus** Route (move) the PC Cursor to the Location of the JAWS Cursor. This moves the insertion point or selection cursor to the location of the JAWS cursor and is equivalent to a single click of the left mouse button.

**Insert Escape** Refresh Screen.
**Delete**  Delete character at cursor; does not announce character deleted; instead announces the new character at the cursor.

**Alt Delete**  Announce active cursor position (in pixels).

**Insert Delete**  Announce PC cursor position in row and column position.

**Alt Insert**  Toggle between insert and overwrite editing modes.

**Alt Down Arrow**  Read dialog prompt.

**Insert 3** (from alpha)  Pass next command through to application.

**Plus**  Invoke PC cursor.

**Minus**  Invoke JAWS cursor.

**Minus**  (tapped twice)  Invoke invisible cursor from either PC or JAWS Cursor.

**Additional Interactive Commands**

**Insert F11**  Say Taskbar

**Insert F12**  Say System Tray

**Control Shift H**  Say hotkey for current control focus.

**Insert Control Down Arrow**  Say Help window.

**Insert Shift Down Arrow**  Say selected text.

**Insert Tab**  Say window prompt and text.

**Insert E**  Say default button of dialog box.
Intermediate Use:

How to Hear All Dialog Options in Settings Box
1. Hold down the Insert key and tap the b key. JAWS will announce the entire contents of the box in the order that the Tab key will take. Current settings are not announced.

How to Navigate with Tab Key Through a Dialog Box
1. Tap the Tab key to navigate forward through options.
2. Shift Tab will navigate backward through options.
3. JAWS will announce each topic box and its current setting.
4. Use the Arrow keys to move up and down within the topic box to hear other possible settings. Each setting is automatically selected as it is read and automatically de-selected if the arrow is moved off the selection.
5. Once the right setting for the topic is selected, resume with the Tab key to move to the next topic box.
6. If a scroll bar is announced in a dialog box, the Right and Left arrows will move the scroll bar selector point. For example, a scrollbar is used to set speech rates and volume.
7. A check box can be selected or de-selected by tapping the Spacebar.

Selecting Text
Key commands for selecting text in Windows applications are listed elsewhere in the training guide. Refer to them for more information. What follows is one way to select two lines of text and read them before deciding to delete, move or copy the text.

1. Type one or two sentences so that text appears on two lines.
2. Make sure the PC cursor is active by tapping the Insert Del key to check status.
3. Move the cursor to the beginning of the first line of text.
4. Hold down the Shift key and tap the End key to select text to end of line. The text will be read.
5. Still holding down the Shift key, tap the Down arrow key to select the next line of text. The text will be read.
6. Text can be de-selected by tapping the Slash(/) key on the numeric keypad.

Copying Selected Text To Another Position In A Document.
1. Enter Control C to copy selected text to the clipboard.
2. Move the cursor to another position in the open document.
3. Enter Control V to place the copied text.
Deleting Selected Text
Once text has been selected, enter Control X.

Moving Selected Text To Another Position In A Document
When text has been cut, move cursor to new position in document and enter Control V.

Formatting Text Once It Has Been Selected
The following keyboard shortcuts will format selected text:
- Control B  Bold
- Control U  Underline
- Control Shift Z  Remove formatting and return text to normal

Advanced Use:

How to use the JAWS cursor like a Mouse Pointer
The JAWS cursor can be used like a mouse pointer with the mouse keys that are described below. To move the Mouse Pointer, use speech pad keys:

- Slash (/) Single Left Mouse Click on speech pad. This selects the item at the JAWS cursor.

- Slash (/) twice in a second, Double Left Mouse Click. This chooses the item at the JAWS cursor.

- Insert Slash (/) Drag an Object on the Desktop. Use the JAWS cursor to point to the object, press Insert and then Slash (/) to lock the mouse pointer on the object, then use arrow keys to drag it. Press Insert Slash (/) to release the drag command.

- Asterisk  Right Mouse Click on speech pad.

Restricting Movement of the JAWS Cursor

- Insert R  Turn JAWS Cursor Restriction On or Off.

If several application windows are on the desktop, it is possible for them to overlap or totally cover one another. This means that parts of several windows could be visible around the active application window. The PC cursor stays within the active window, which means it will not read information from the surrounding windows. The JAWS cursor also stays within the active window.
The restriction setting does not affect the movement of the PC cursor. When restriction is turned on, the JAWS cursor is restricted to the active section of the screen where it is currently located. If it is in a dialog box when restriction is turned on, it can only read the active dialog option. When using the JAWS cursor restriction, in order to ensure that the cursor is being restricted to the proper section of the desktop, it is best to do the following:

1. Route the JAWS cursor to the location of the PC cursor with **Insert Minus**.
2. Turn on JAWS cursor restriction with **Insert R**.

**How to use the JAWS Configuration Manager**

The Configuration Manager contains a Set Options menu. When you choose a Set Options menu item, a dialog opens. The Configuration Manager includes the following menu options: User, Text Processing, Window Classes, Graphics and Symbols, Cursor, Keyboard, Braille, and Advanced. These dialogs enable you to configure your applications to your own specifications. Use the hotkey **Insert** (alpha keyboard) 6, or

1. Press **Insert J** to activate the JAWS application.
2. Press Alt U to open the Utility menu item.
3. Press C to open to Configuration Manager.

**Settings led by Configuration Manager**

Using the command for context-sensitive help, **Insert F1**, when the focus is on an element in a configuration dialog, will cause JAWS to speak a help message regarding the nature of the element (e.g., typing interrupt), its function, and its default setting.

- **User Options**
  These include typing echo, screen echo, verbosity level, typing interrupt, reading interrupt, key repeat and Insert key mode.

- **Text Processing**
  These include punctuation mode, filter repeat characters, number processing, list item, mixed case processing, dictionary processing, speak window type first, speak window state first.

- **Graphics and Symbols**
  These include graphic verbosity, ANSI character verbosity, graphic dimensions, graphics mode toggle.

- **Advanced Options**
Among these options is found the "go-to-sleep" checkbox. This can be used to silence JAWS in a particular application. To silence JAWS in a particular application, open the application itself, with JAWS running; open the Configuration Manager and select the go-to-sleep option from the Advanced menu. Save the change. Now, if JAWS is loaded and this application loads in, JAWS will not speak in the application at all, but will in all others.

There are other main types of options, but they relate to advanced use.

**How to use the JAWS Keyboard Manager**
The keyboard manager is the assignment of keystrokes to JAWS activities. It is important to understand a little about scripts before learning about Keyboard Manager. All JAWS activities assigned to keystrokes are scripts. A script is a small computer program that is how JAWS reacts and what you hear. To open Keyboard Manager, use Insert (alpha keyboard) 8, or
1. Press Insert J to activate the JAWS application.
2. Press Alt U to open the Utility menu item.
3. Press K to open the Keyboard Manager.

**How to use the JAWS Dictionary Manager**
This application allows you to alter the JAWS Dictionary. The JAWS Dictionary is a collection of files that stores all the correctly pronounced words. The Dictionary Manager is the tool that enables you to manage your own JAWS Dictionary files. Press INSERT+D to start the Dictionary Manager and add words to your dictionary.

Use the Dictionary Manager to alter words for specific applications or all your applications. If you want your changes to be saved to all your applications, save the changes to the default file.
1. Press Insert J to activate the JAWS application.
2. Press Alt U to open the Utility menu item.
3. Press K to open the Keyboard Manager.

**How to use the JAWS Frame Manager**
You can use Frame Manager to create and work with frames. Frames are boundaries on a screen for which you define a JAWS action.
• Use a frame to define an area of the window or screen to be spoken automatically.
• Use a frame to define an area of the window or screen to be spoken when a keystroke is pressed.
• Use a frame to define an area of the window or screen for JAWS to ignore.
• Use a frame to define an area of the window or screen for JAWS to treat differently than other areas.
To open Frame Manager, use Insert 9, or
1. Press **Insert J** to activate the JAWS application window.
2. Press **Alt U** to open the Utility menu item.
3. Press **F** to open the Frame Manager.

**How to use the JAWS Script Manager**

Small script files are created, edited and compiled with Script Manager. A script is a small computer program that controls how JAWS reacts and what you hear. For example, when Insert 5 is pressed, the SayWord script runs. In addition to just saying the current word, it also checks to see if Insert 5 has been pressed twice, in which case it spells the word. Groups of scripts are stored in the script files. There are two basic types of script files: default and application. The default script files contain those scripts and other things that are always available. Application script files contain scripts and other things that are only available when a particular application program is running.

1. Press **Insert J** to activate the JAWS application.
2. Press **Alt U** to open the Utility menu item.
3. Press **S** to open the Script Manager.

**Notes:**

**Pricing:**
For extensive information about pricing, site licenses and software maintenance agreements (SMA), use this web address: [www.hj.com/JFWMFWPricing.html](http://www.hj.com/JFWMFWPricing.html)

**Installation:**
The NT version does not use MS Active Accessibility so there will be differences in functionality between the Win 95 and NT versions in applications that use Active Accessibility, e.g., MS Office.

When installing new video drivers on your system, you must first uninstall MAgiC and/or JFW, install the new drivers, then reinstall MAgiC and/or JFW. If you have both products installed on your computer, you must uninstall them in this order: first JFW, then MAgiC. You must re-install in this order: first MAgiC, then JFW.

It may also be possible to unload the JFW NT video driver with the following command from a command line window: c:\winnt\system32\setjv /R

JFW will reset itself when restarted.

If you are using a remote software application such as PC Anywhere or Remotely Possible, you must first uninstall it before installing JFW. Once you have installed JFW you can re-install your remote access program. When installing on a dual boot system with NT and some other OS, you must
first install under NT. After installing under NT, you can reboot to Win 95 or Win 98 and reinstall JFW. This will avoid authorization conflicts.

Note that with JFW NT version, the authorization must be on the hard disk and not on a floppy as is possible with the Win 95 version.

**Network:**
Site license costs: for 5 users, $2,400; for 10 users, $4,000; for 15 users, $6,000; for 20 users, $6,500. The SMA or Software Maintenance Agreement is ten percent of the JFW license price and entitles the district to the next two JFW upgrades.

The following is from the Henter-Joyce web site:
"The current version of JAWS for Windows 3.0 does not support multiple profiles or an actual network installation. If you want to use your JAWS for Windows 3.0 application on a network, there are some suggestions we can make that may or may not help your specific situation; although we will not be able to provide support if you encounter network problems. Our first suggestion is that we recommend you install both JAWS for Windows and the Authorization Key on each workstation required. We feel that this is the most reliable and trouble free method.

Other possible solutions would be to install JFW on the network drive and install the JFW authorization on a workstation. However, it is sometimes possible to install both the JAWS software and authorization on a network drive. In doing so, then JFW is conceivably accessible from any workstation on the network. In essence, it becomes a one-user network with one person being able to access JAWS for Windows from anywhere in your network. A very necessary caveat must be mentioned at this point. All of this depends on how your network is configured and the way you installed the software. This is not a guarantee that installing JAWS for Windows on your network will work.

The obvious drawback to installing one copy of JAWS for Windows on the network is that it cannot be customized for each user. If you had two users of JFW, they would be accessing the same configuration files. These files cannot be customized for each user within the same copy of JAWS for Windows. As a workaround to this situation, If you want to have two people on the same network with different configurations, you can install two copies of JAWS for Windows in separate folders on the network. As long as these two people access their own folders and run JFW from within their own folders, they should be able to customize their own configuration files. Most JAWS for Windows Authorization Keys will allow more than one copy of JFW
to be installed. You should test this with your own authorization and within your own network environment.

If you need to put JAWS for Windows on a restricted network, JFW must be installed by you or the user is under administrative privileges. The JFW user must also have READ access to the JFW30 directory and all of its subdirectories, as well as the Windows and Windows System subdirectories. Without WRITE access, the user won't be able to personalize JFW. This limits the powerful customization features JAWS for Windows is recognized for."
# JAWS ver. 3.3
## PC CURSOR FUNCTIONS

### Num Lock Key - off

### 7 Home
Reads beginning of text line or first item in list box.  
Ins + 7 = reads from beg. of line up to cursor, but not including cursor.

### 8 ot
Reads prior line.  
Ins + 8 = reads whole line

### 9 PgUp
Moves insertion point up one screen.  
Ins + 9 = reads from cursor to end of line.

### 4 4-
Select previous icon or menu item or move insertion point to previous character.  
Ins + 4 = reads previous word

### 5
Reads current character.  
Ins + 5 = reads current word.  
Ins + 5 twice to spell word.

### 6
Select next icon or menu item or move insertion point to next character  
Ins + 6 = reads next word

### 1 END
Reads end of line or list box.  
Ins + 1 = reads top line of the window

### 3 PgDn
Reads next line down below.  
Ins + 2 = reads to end of file or box

### 0 Insert
With Alt, toggle between Insert and Overwrite mode.

### 0 Insert
With Alt = speaks active cursor

### * right mouse button

### / left mouse button

### JAWS cursor
ins + - = routes to PC cursor

### PC cursor on
Ins + + = routes to JAWS cursor

### Enter
## JAWS ver. 3.3

### JAWS CURSOR FUNCTIONS

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Num Lock Key</td>
<td>- off</td>
</tr>
<tr>
<td></td>
<td>- left mouse button</td>
</tr>
<tr>
<td></td>
<td>- single click selects</td>
</tr>
<tr>
<td></td>
<td>- double click chooses</td>
</tr>
<tr>
<td></td>
<td>- shift + / = locks left mouse button</td>
</tr>
<tr>
<td></td>
<td>- right mouse button</td>
</tr>
<tr>
<td></td>
<td>- right button mouse click</td>
</tr>
<tr>
<td></td>
<td>- ins + * = locks right mouse button</td>
</tr>
<tr>
<td></td>
<td>- JAWS cursor on</td>
</tr>
<tr>
<td></td>
<td>- ins + - = routes to PC</td>
</tr>
<tr>
<td>7 Home</td>
<td>- Reads beginning of line.</td>
</tr>
<tr>
<td></td>
<td>- Ins + 7 = reads from beg. of line up to cursor, but not including cursor.</td>
</tr>
<tr>
<td>8 $</td>
<td>- Reads previous line.</td>
</tr>
<tr>
<td></td>
<td>- Ins + 8 = reads whole line</td>
</tr>
<tr>
<td>9 PgUp</td>
<td>- Reads top of application or child window.</td>
</tr>
<tr>
<td></td>
<td>- Ins + 9 = reads from cursor to end of line.</td>
</tr>
<tr>
<td>4 4</td>
<td>- Reads previous character.</td>
</tr>
<tr>
<td></td>
<td>- Ins + 4 = reads previous word</td>
</tr>
<tr>
<td></td>
<td>- Reads current character.</td>
</tr>
<tr>
<td></td>
<td>- Ins + 5 = reads current word</td>
</tr>
<tr>
<td></td>
<td>- Tap twice to spell word</td>
</tr>
<tr>
<td>6 +</td>
<td>- Reads next character.</td>
</tr>
<tr>
<td></td>
<td>- Ins + 6 = reads next word</td>
</tr>
<tr>
<td>1 END</td>
<td>- Goes to end of line and reads last word or graphic.</td>
</tr>
<tr>
<td></td>
<td>- Ins + 1 = reads top line of the window</td>
</tr>
<tr>
<td>2 4'</td>
<td>- Reads next line down below.</td>
</tr>
<tr>
<td></td>
<td>- Ins + 2 = reads from cursor to end of window</td>
</tr>
<tr>
<td></td>
<td>- (say all moments)</td>
</tr>
<tr>
<td></td>
<td>- Ctrl + 2 = reads active child window</td>
</tr>
<tr>
<td>3 PgDn</td>
<td>- Reads bottom of application window or child window</td>
</tr>
<tr>
<td></td>
<td>- Ins + 3 = reads last line of the window (status line)</td>
</tr>
<tr>
<td>Enter</td>
<td></td>
</tr>
<tr>
<td>0 Insert</td>
<td>- With Alt, toggle between Insert and Overwrite mode</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>. Delete</td>
<td>- Deletes character at cursor</td>
</tr>
<tr>
<td></td>
<td>- With Alt = speaks active cursor</td>
</tr>
</tbody>
</table>

With Alt, toggle between Insert and Overwrite mode.
Kurzweil 1000 4.0 (Win 95/98/NT)

Publisher: Kurzweil Educational Systems, Inc.
411 Waverley Oaks Road
Waltham, MA 02154
800-894-5374
http://www.kurzweiledu.com

Retail Cost: $1295.00

System Requirements:

- Pentium 133 MHz processor or higher
- 24 MB of RAM (32 MB recommended)
- 60 MB available hard disk space available
- 6X CD-ROM drive
- Single-pass color flat-bed scanner (TWAIN compatible)
- Sound Blaster sound card or compatible
- Microphone, if you wish to use the voice command option
- Full size keyboard or 17-button Kurzweil 1000 keypad
- Windows 95/98/NT operating system

Description:

The Kurzweil 1000 is a computer-based reading system that converts printed material into speech. Users navigate through their documents by using the optional keypad that comes with it or by using the numeric keypad on a full size keyboard. In addition to reading documents, users can use dictionary and spelling tools to enhance their reading. Kurzweil 1000 documents can also be managed from the keypad.

The Kurzweil 1000 now supports Braille output as well as print text. This option resides in the Print dialog box. The capability of reading multiple page TIFF files has also been incorporated into version 4.0.

Recommended Uses:

The Kurzweil 1000 was designed for non-sighted users, and is useful in any setting where students need access to print materials. The difference between the Kurzweil 1000 and the 3000 is that the latter, designed for persons with learning disabilities, supports graphics, and allows students to visually read on an exact scan of a page.
Basic Use:

1. Basic use involves using the Reading Keypad to first scan a document then read it. Refer to the picture below to find these keys. Insert your document into the scanner facedown. Tap the **Start & Stop Scan** button (plus key on numeric keypad) to begin scanning.

2. After the page has been scanned, use the **Start & Stop Reading** button (Zero key on numeric keypad) to read through the page.

3. To learn about the other keys, use the **Help and Status** key.

### The Reading Keypad

<table>
<thead>
<tr>
<th>Cancel</th>
<th>Erase Text</th>
<th>Dictionary</th>
<th>Accept</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume Up</td>
<td>Speed Up</td>
<td>Reading Unit</td>
<td></td>
</tr>
<tr>
<td>Volume Down</td>
<td>Speed Down</td>
<td>Column Went</td>
<td></td>
</tr>
<tr>
<td>Rewind</td>
<td>Forward</td>
<td>Go To Page</td>
<td></td>
</tr>
<tr>
<td>Start &amp; Stop Reading</td>
<td>Spell</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No Function</th>
<th>Paste Page</th>
<th>No Function</th>
<th>Change Keypad Layer</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>Insert or Rescan</td>
</tr>
<tr>
<td>Enable Voice Command</td>
<td>Insert Bookmark</td>
<td>No Function</td>
<td></td>
</tr>
<tr>
<td>Rewind by Unit</td>
<td>Forward by Unit</td>
<td>Go To Bookmark</td>
<td>Help</td>
</tr>
<tr>
<td>Shift</td>
<td>Spell</td>
<td>Spell with Mnemonics</td>
<td>Status</td>
</tr>
</tbody>
</table>
**Intermediate Use:**

1. Below is the File Management Keypad. To change keypads, press and hold down the Start and Stop Reading key, then press and release the Accept key, then release Start and Stop Reading.

**File Management Keypad**

<table>
<thead>
<tr>
<th>Cancel</th>
<th>Favorite Folders</th>
<th>Favorite Files</th>
<th>Accept</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Folder or A through E</td>
<td>New Folder or F through J</td>
<td>Delete Folder or K through 0</td>
<td>No Function</td>
</tr>
<tr>
<td>Open File or P through T</td>
<td>Close File or U through Z</td>
<td>Delete File or 0 through 4</td>
<td>No Function</td>
</tr>
<tr>
<td>Save File or 5 through 9</td>
<td>Save File As or Space</td>
<td>Export File Format</td>
<td>Help Status</td>
</tr>
<tr>
<td>Start &amp; Stop Reading</td>
<td>No Function</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No Function</th>
<th>Delete Favorite Folder</th>
<th>Delete Favorite File</th>
<th>Change Keypad Layer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Folder under Current</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
</tr>
<tr>
<td>Open File or P through T</td>
<td>Close File or U through Z</td>
<td>Delete File or 0 through 4</td>
<td>No Function</td>
</tr>
<tr>
<td>Save File or 5 through 9</td>
<td>Save File As or Space</td>
<td>Export File Format</td>
<td>No Function</td>
</tr>
<tr>
<td>Start &amp; Stop Reading</td>
<td>No Function</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**File Management Keypad**

**File Management Keypad, Shifted**

<table>
<thead>
<tr>
<th>No Function</th>
<th>Save in Export Format</th>
<th>No Function</th>
<th>Help Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift</td>
<td></td>
<td>No Function</td>
<td></td>
</tr>
</tbody>
</table>

---

ACT Overview  Page 41
Advanced Use:

1. Below is the Settings Keypad. Change to this keypad and use the Help & Status key to learn about these keys.

## Settings Keypad

<table>
<thead>
<tr>
<th>Cancel</th>
<th>Page Orientation</th>
<th>Numeric keypad Layout</th>
<th>Accept</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Reading Voice</th>
<th>System Voice</th>
<th>Progress Messages</th>
<th>No Function</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Dynamic Threshold</th>
<th>Scan Mode</th>
<th>No Function</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>No Function</th>
<th>No Function</th>
<th>No Function</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Help Status</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Start &amp; Stop Reading</th>
<th>Save or Restore Settings</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>No Function</th>
<th>No Function</th>
<th>No Function</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Help Status</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>No Function</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Shift</th>
<th>No Function</th>
</tr>
</thead>
</table>

## Settings Keypad, Shifted

<table>
<thead>
<tr>
<th>No Function</th>
<th>No Function</th>
<th>No Function</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Brightness</th>
<th>No Function</th>
<th>No Function</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>No Function</th>
<th>No Function</th>
<th>No Function</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Help Status</th>
</tr>
</thead>
</table>

Notes:

Be sure to read the installation notes, especially if you have a previous version or the Kurzweil 3000 installed. In general, the rule is to install the older program first, then the newer version.
Publisher: Kurzweil Educational Systems, Inc.
411 Waverley Oaks Road
Waltham, MA 02154
800-894-5374
http://www.kurzweiledu.com

Retail Cost: $1995.00

System Requirements:
• Pentium PC Processor (preferably 166MHz or higher)
• 32 MB RAM - Black and white scanning
• 64 MB RAM - Color scanning
• 70MB of available hard disk space (with 80 MB reserved as swap space for virtual memory)
• 6X CD-ROM drive
• Sound Blaster or compatible sound card (16 or 32 bit)
• Microphone and speakers
• SVGA Monitor (resolution of 800x600 or higher)
• Fully TWAIN compatible scanner (Scan/Read only)
• Full size keyboard and mouse
• Windows 95/98/NT operating system

Description:
The Kurzweil 3000 is a computer-based reading system that converts printed material into speech. Users can hear printed words spoken aloud as they read them on the computer screen. In addition to reading documents, users can use dictionary and phonetic spelling tools to enhance their reading. Scanned pages appear on the screen as they appear in the original material. As the Kurzweil 3000 reads, it highlights each word and its context. The reading voice, background/foreground colors, and text size are easily adjustable. The 3.0 version has added a number of new features as follows:

Redesigned user interface
1. New, brighter icons.
2. Easy access to more features, like document and page thumbnails.
3. Re-organized option tabs.
4. A customizable right button menu.

New study skills and authoring tools
6. Voice notes.
8. Improved note handling, including numbered note anchors.
10. Word prediction.
12. User selectable block or word highlighting for typed documents.
13. Improved dictionary display.
15. Syllable highlighting in the phonetics display.
16. A Synonyms button on the main toolbar (at resolutions of 1024 x 768 or higher).

More scanning features
17. The newest version of ExperVision's optical character recognition (OCR) software.
18. Enhanced document feeder support.
20. Scan area option.

New editing features
22. Undo feature (undo up to 100 edits in typed documents).
23. Image selector.
24. Clipboard reader.
25. Extract text, notes, and/or highlights.
26. Zone editor.

New test taking features
27. Password control for dictionary, thesaurus, spell-checker, and word-prediction features.
28. Pause at Bookmarks.

New view and navigation features
29. Thumbnail display of scanned document.
30. Optional multiple-word display in Magnifier window.
31. Annotation display/hide feature.
32. Go To page dialogue.

Improved software performance
33. Program starts up faster.
34. Read by Heading algorithm is improved.

Recommended Uses:
The Kurzweil 3000 was designed for sighted users who have difficulty reading. It could be used in any setting where students need access to print materials. It may also serve as a writing environment for users who would benefit from its special features. Because there are many on-screen controls available, it is not as suitable as a reading machine for non-sighted students as the companion product the Kurzweil 1000 which provides easy access for non-sighted users.
Basic Use:

1. Start the Kurzweil 3000. Enter your name if prompted. A window appears with a number of menus, buttons, and combo boxes.
2. Run the mouse pointer over the buttons, pausing over each without clicking and read the tool tips that appear which describe each button’s function.
3. To scan a document, place it in the scanner and click the Scan button.
4. After the image of the document appears on the screen, resize it to your desired size by choosing a percentage in the Zoom box or by clicking on the little arrows on the box.
5. Read the document by clicking on the Play button. Notice the Play button changes to a Pause button to be clicked when you wish to stop reading.
6. To get more information on a word, highlight any word in the document by double-clicking on it. Click on the Dictionary button in the toolbar.
7. Click the Read button to hear the definitions read aloud. To see a list of words with similar meanings, click Get Synonyms.

Intermediate Use:

1. Click the right mouse button in the document to see a context menu of choices to make. This method may prove to be quicker.
2. To select a reading unit, choose from the Read By list box either by word, by phrase, by sentence, by line, or by paragraph.
3. To select a reading mode, choose from the Read Mode list box. Continuous mode will read until you stop it with a mouse click or clicking on the pause button. If you choose Self-Paced, reading will pause at the end of whatever reading you have selected.

Notes:

Installation:

The installation is very simple, just insert the CD and follow the on-screen directions. The authorization floppy disk must be in the A: drive during installation when it is automatically installed. There are three authorizations on the floppy disk. If you need to uninstall, there will be a step in the process that places the authorization back on the floppy disk.

However, if you have a previous version or a version of Omni/Kurzweil 1000 the sequence of installation becomes important. As a general rule, install the older of the Kurzweil programs first, then the newer one to avoid conflicts.

If installing on Win NT, be sure to obtain the NT drivers for your scanner.
MAGic NT 5.1 (NT)

Publisher:  
Henter-Joyce, Inc.  
11800 31st Court North  
St. Petersburg, FL 33716-1805  
(800) 336-5658  
http://www.hj.com

Retail Cost: $995

System Requirements:
- 486 or later PC running Windows NT 4.0
- 16MB RAM (NT Minimum)
- 256-color display driver at any resolution
- 650K free hard disk space

Description:
MAGic (Magnification in Color) is screen magnification software that enlarges a PC, laptop, or notebook screen from 2 to 20X! It is ideal for low-vision computer users or anyone who is required to spend extended periods of time in front of a computer screen. MAGic enlarges text, graphics, or any Windows system screen, maintaining type-through access in both text and graphics mode. This software-only solution is easy to install and requires minimal memory.

Recommended Uses:
MAGic is intended for use by persons with low vision.

Basic Use:
1. Open the program by choosing MAGic from the Start/Programs/MAGic menu. The MAGic dialog appears. Settings change via the Preferences menu or the 4 tabs below the menu bar.
2. To turn on magnification, from the magnification area of the magnification tab, click on the up and down arrows to set the level of screen magnification, then click the On box to turn on the magnification.
3. Screen Color: Mark Normal to keep the screen colors as is. Mark Reverse to reverse the screen colors. Screen colors are reversed only when the screen is magnified.
4. Mouse Color: Mark Normal to keep the mouse pointer colors as is. Mark Reverse to reverse the mouse pointer colors. Mouse pointer colors are reversed only when the screen is magnified.
5. Locator On: Mark On to show the Locator; unmark On to not show the Locator. The Locator is for full screen magnification only. Pressing <Ctrl+Shift+L> also toggles the Locator on and off. The Locator is a pair...
of rectangles: one rectangle along the left edge of the screen and one
rectangle along the top edge of the screen. The position of the rectangles
matches the position of the viewport relative to the desktop. The
rectangle color is the reverse of the screen content.

Notes:

Installation:

When installing new video drivers on your system, you must first uninstall
MAGic and/or JFW, install the new drivers, then reinstall MAGic and/or
JFW. If you have both products installed on your computer, you must
uninstall them in this order: first JFW, then MAGic. You must re-install in
this order: first MAGic, then JFW.

It may also be possible to unload the JFW NT video driver with the following
command from a command line window: c:\winnt\system32\setjv /R
JFW will reset itself when restarted.

The installation setup automatically moves the authorization from the floppy
to the hard disk. Use the HJAUTH.EXE application to manage the
authorization process in NT.
Publisher: Ai Squared  
P.O. Box 669  
Manchester Center, VT 05255  
(802) 362-3612  
http://www.aisquared.com/

Retail Cost see notes section

System Requirements:

486 or higher processor; Windows 3.1 or 95/98, 16,256 or High Color display driver; minimum 8 MB RAM (16 MB preferred), Windows sound card or SSIL speech synthesizer (required for levels 2 and 3 only).

Description:

ZoomText Xtra comes in two levels now and a third is scheduled for release sometime in 1998. Level 1 is a screen magnifier for the Windows 95/98 environment. Level 2 offers a fully integrated magnifier and screen reader, designed specifically for the low-vision computer user. Level 3, which is still under development, will add scanning, OCR, form-filling and printing.

Another innovative feature of ZoomText Xtra is its document reading module, called DocReader. Existing in all three product levels, DocReader is a full-screen environment for reading text from any Windows application. DocReader automatically reads through complete documents, including web pages and email.

This version also provides Microsoft's Active Accessibility, which should be installed if using Microsoft Office 97 applications.

Recommended Uses:

ZoomText is intended for use by persons with low vision. It may also be of value to individuals with learning disabilities.

Basic Use:

1. To start ZoomText, choose the ZoomText icon from the Start menu.
2. When ZoomText is active, pressing Alt Delete turns it off. To turn ZoomText back on, press Alt Insert.
3. When ZoomText is active, pressing Alt Insert or Ctrl Shift U will display the ZoomText User dialog box. Options may be selected from menus or from Tool icons. Selections may be made from the keyboard or with a mouse.
4. Choose **Contents** from the **Help** menu and browse through the excellent descriptions of the program's functions.

**Intermediate Use:**

**Enlarging and Changing Text Size**
Text may be enlarged in two ways: from the keyboard, Alt followed by the **Plus** or **Minus** key will enlarge or reduce text size.

From the ZoomText menu bar: from the **Options** menu select **Display** then click the **Magnification** tab if it is not already the front tab. From this dialog box it is possible to set horizontal and vertical size, whether the text is proportional (e.g. 3X [Horizontal] by 3X [Vertical] or not, and whether the text is to have smoothed edges, possible with 256 display monitors).

**Choosing Display Style**
From the ZoomText menu bar: From the **Window** menu select the display desired. The default view is **Overlay**. This view places a window in the lower right quarter of the screen. Cursor and Pointer tracking are on. Moving the mouse pans the screen display in this viewing window. The remaining 75% of the screen remain at normal magnification.

There are five main display options: Full Screen, Lens (a movable, sizable rectangle), H-split (horizontal split) and V-Split (vertical split).

**Overlay**
The default setting for ZoomText places the Overlay window in the lower quadrant of the screen. Moving the mouse pans the screen; with tracking on, activities using the cursor and mouse are focused in the window.

**Re-sizing the Overlay View**
It may be useful for students with learning disabilities to re-size the overlay so that only one line of text is magnified. This environment can be used for writing or reading. To do this:

1. Bring up the User dialog box with Alt Insert or with Shift Control U.
2. Select the Re-size icon (the 1st from the left in the lower row of Tool icons.)
3. Click the mouse pointer on one of the rectangular "handles" which now appear on the outline of the current overlay window.
4. Click and drag the window borders to the desired positions (left border to the left margin, lower border up a bit, top border down as far as possible, right border a little to the left, if necessary.) Click the right mouse button to keep the desired size.
**Full Screen**
For persons comfortable with the entire screen magnified. Moving the mouse (with tracking on) pans the magnified view.

**H-Split**
A magnified view of the screen is displayed in the lower half of the screen. Moving the mouse pans the view in the window. Cursor track places cursor activity in this view.

**Saving Configurations**
Configurations are easily saved or loaded into memory. Because a user can easily save a personalized configuration, it is easy to make ZoomText work in a highly customized setup.

To Save a Setup
1. Make necessary adjustments to ZoomText values.
2. Bring up the ZoomText User window with Alt Insert.
3. Open the File menu and select Save As.
4. Name the file (e.g., suzy). ZoomText automatically adds a .zxc extension.
5. The new configuration file is now listed at the bottom of the File menu, and can be loaded from there.

**Loading Configurations**
There are several different ways to load a configuration: From the File menu, select Open and select the file. Or from the File menu, select the name of the configuration from the bottom of the file menu if it is there. During a work session, once a configuration has been loaded, its name is placed at the bottom of the File menu.

**How to Scroll Text**
Having text scroll by in a magnified view can be an efficient way for some persons to read text. Entering the hot key command Ctrl Shift S brings up the Scroll icon. Click and hold down the mouse button and the screen starts the scrolling action in the direction of the mouse drag. Click the right mouse button or press Escape to leave the scroll mode.

**DocReader**
1. Click the DocReader button, the open book icon without the pointer, to launch DocReader to read text from the last active application. The DocReader module is a reading environment that reformats, magnifies and speaks text (level 2 & 3 only) from any Windows application.
2. The text of the last opened application is reformatted into the DocReader window and a toolbar appears at the top. This toolbar is used to read
through the text in a method similar to using a tape recorder's buttons. Click on the first button to start reading through the enlarged text. Click it again to stop. For more detailed descriptions of the buttons, see the descriptions from the Help menu.

3. With Level 2, speech output is also possible and can be controlled either from the DocReader window or the icons on the application. The icons control the various aspects of the speech function. To learn each icon's function, from the ZoomText Xtra application, click on the ? icon, then on the icon you wish to learn about. A short description will pop up which explains the function of that icon.

Notes:

**Level 1 Pricing**
ZX Level 1 (for Windows 95/98 and 3.1) $395
ZX Level 1 Plus (includes ZoomText for DOS) $595
ZX Level 1 Upgrade * (from older ZoomText versions) $95

**Level 2 Pricing**
ZX Level 2 (for Windows 95/98 and 3.1) $595
ZX Level 2 Plus (includes ZoomText for DOS) $795
ZX Level 2 Upgrade * (from ZX Level 1) $200
(from older ZoomText versions) $195

**Site License Pricing**
Many site license options are available. For details, see the web site listed above.

**Installation**
ZoomText Extra Level 2 installation depends on which synthesizer option you will be installing. If you will be using a hardware synthesizer or if you have a SoundBlaster and TextAssist software installed, use the SSIL option during installation. If you choose the Windows sound card option, what you see next depends on what is already installed. If you have another Microsoft Speech Application Programming Interface (SAPI) software synthesizer installed, e.g., FlexTalk, you will see it listed along with TruVoice, the software synthesizer that comes with ZoomText Extra Level 2.

Currently, if you install TruVoice, your other SAPI synthesizers will become unavailable for your other applications. You may also have difficulty getting other SAPI synthesizers to work with ZoomText Extra Level 2. Until these problems are resolved, we recommend using the SSIL hardware synthesizer or TextAssist option if you have it available. Another option is to install ZoomText Extra without speech on those computers that have other software synthesizers in use.
Network
This version allows users to specify both a directory for the hardware profile file, *ZxHdw.ini*, and the user configuration file, *Username.zxc*, so unique user settings can be preserved. This setup allows the program to be stored on a server, the local hardware profile to be stored on the local computer, and a particular user configuration to be stored on the server so that user has access to that configuration from any computer that has access to the server. To do this, add the following to the command line of the ZoomText icon.

```
/c=c: \temp w:zt5 \users \username
```

where `/c=` is a switch to allow the following process, `c: \temp` is an example path to a directory that stores the local hardware profile file and `w:zt5 \users \username` is an example path to a directory on the server that stores `username`'s configuration file. Note that there must be a space before the `/c=c: \temp` part and a space after that part to separate the two additions to the command line.

The names of ZoomText configuration files, which are loaded by `LoadConfigFile` hotkeys, are now stored in a global .INI file. This allows you to switch configurations without losing the configuration hotkey settings. A new file, `ZXCFILES.INI`, contains the names of the hotkey configuration files and is stored in your ZoomText directory (or in the directory specified by the `/C= command line parameter). This feature was added in version 6.01.